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Introduction
VuePrint is a program that lets you view, print, and convert graphics files, while at the same 
time playing sound and movie files.

Some of the main features of VuePrint are:

Reads and writes 6 different types of graphics files

Reads and writes internet graphics files

Has a built-in screen saver

Includes a slide show feature with more than a dozen options

Displays multiple images in a window (thumbnails) 

Supports all graphics displays, including 16-color laptops

Supports copying to the clipboard, and pasting from the clipboard

Uses 12 different effects for repainting the screen

Has menu options to install and remove VuePrint

There are two Editions of VuePrint:

16-bit Edition - all versions of Windows

Pro/32 Edition - Windows 95, Windows NT, Windows 3.1/win32s

The 16-bit Edition is distributed as Shareware, and the Pro/32 Edition is usable by registered 
users only.

To view images, use the <File|Open...> command and choose the image you want to view.    
When you are done viewing images, choose <File|Exit...> to leave VuePrint.    Note that each
of the common commands in VuePrint has a one-letter keyboard shortcut.    For instance, to 
open a file for viewing, press the <O> key, and to exit VuePrint, press the <X> key.    The 
shortcut keys for each command are displayed on the right-hand side of each menu.

The most common way of viewing images is pressing <O> and using the mouse to double-
click on the image you want to view.    If you then want to view other images in the same 
directory, just press the <Space> bar to go to the next image in the list, the <Backspace> 
key to go to the previous image, and the <Enter> key to display a randomly selected image 
in the same directory.

If you are looking through a large number of images, and want to view them quickly, press 
the <Q> key.    To view the full-size image, just press the <Q> key again.    Note that many of
the options in the varous menus can be turned on and off this way by pressing a single key.

If you want to get rid of the menu bar entirely, you can turn it on and off by pressing the 
<Esc> key.    This is sometimes useful if you want an uncluttered screen.

You have probably figured out by now that VuePrint has a lot of different options.    The one 
thing to remember is that you can always get the program back to reasonable (i.e. default) 
option values by pressing <F7>, and you can save the current option settings by pressing 



<F5>.    VuePrint will start up with the options in effect that you have saved when you press 
<F5>.    You can always get access to this help file by pressing <F1>.

If you want to view many images per screen, you can use the Thumbnails feature of 
VuePrint.    Press <O> to open up some files, then press <T> to display a page of 
thumbnails.    Every time you press <T>, you will get a new page of thumbnails, and when 
you are on the last page, pressing <T> for the last time will revert back to no thumbnails.    
You can also press the <B> key to turn on thumbnails, but then you have to press the space 
bar each time you want to load a new image.    The <B> key toggles thumbnails on and off.

Printing the current image (or the thumbnails) can be done by pressing <P> or choosing 
<File|Print...>.    You can control the placement of the image on the page by using the <File|
Margins...> command or pressing <M>.

You can save the current image in a new file format by pressing <V> or choosing <File|Save 
as...>.    If thumbnails are being displayed, the thumbnails will be saved in the file.

If you want to use VuePrint as a screen saver, use <Utilities|Install screen saver> followed 
by <Utilities|Configure screen saver>.    If you want to turn the screen saver off, use 
<Utilities|Remove screen saver>.

If you decide to remove VuePrint from your system, use the <Utilities|Remove VuePrint> 
command.    This will restore the File Manager Associations that were in place before VuePrint
was installed.    You can also use the File Managers <File|Associate...> command to do this.    
If you want to remove the VuePrint screen saver, run VuePrint and choose the <Utilities|
Remove screen saver> command

Each of the menu commands and options are described in more detail below.



Registering
VuePrint may be used and evaluated during a 15 day free trial period.    If you decide to 
register your copy of VuePrint, you will get:

o free upgrades (if you download them yourself).    There were new versions of 
VuePrint released every few months in 1994 and 1995, all of which were free 
upgrades to registered users.

o four programs in one - a viewer, a screen saver, an unzip utility, and a 
program to read and write internet graphics files that are in the uuencode 
format.    Normally you would have to buy each of these four programs 
separately. 

o the right to install VuePrint on four computers that you use.    Since many 
people use multiple computers, this is more convenient and economical than 
registering multiple copies. 

o free support for VuePrint via electronic mail (e-mail). 

o a serial number that disables the registration reminder. 

o the Pro/32 Edition of VuePrint (if you download it yourself).    This Edition of 
VuePrint is for systems that can run WIN32 programs, including Windows 95, 
Windows NT, and Windows 3.1 with win32s installed.    It is available from 
America Online, CompuServe, and most Internet-connected services by using 
the FTP (File Transfer Protocol) capability of these services.      When you 
register VuePrint, you will receive instructions on how to download this 
software.    The Pro/32 Edition is significantly faster than the 16-bit version 
when reading JPEG files.

The $40 registration fee can be paid three different ways:

1) If you want to pay the $40 registration fee by credit card, please send your 
credit card number, expiration date, and full name (as it appears on the card) 
via electronic mail (e-mail) to either screen name EdHamrick on America 
Online, 71470,3236 on CompuServe, or EdHamrick@aol.com from other 
services. You will be sent your permanent VuePrint serial number by e-mail, 
usually within 24 hours. There is no additional charge for registering by credit 
card.    Note that e-mail from one AOL or CompuServe subscriber to another on
the same service is quite secure.

2) If you have a CompuServe account, you can use the on-line software 
registration service. This service will charge your account $40, and will 
automatically send Hamrick Software an e-mail message that you have 
registered. To use this service, go to the SWREG forum on CompuServe, and 
use Registration ID 1883.    In return, you will be sent an e-mail message with 
your permanent VuePrint serial number, usually within 24-hours.    There is no 
additional charge for using the SWREG service. 

3) If you would prefer to register by surface mail, please send the $40 
registration fee to:

Hamrick Software
4025 E. Chandler Blvd.
Suite 70-F16



Phoenix, AZ 85044

Please include either a check or a credit card number/expiration 
date/signature.    If you include your e-mail address with your payment, you 
will be sent your permanent VuePrint serial number by e-mail.    Otherwise, it 
will be sent by surface mail.    Cash in equivalent amounts of other currencies 
is also accepted.    (If you are an America Online member, your screen name is
the same as your e-mail address.)

Note that you will not receive a diskette or a manual in the mail when you register, since you
already have the complete VuePrint program, including the available documentation (this 
help file).    This allows us to not charge anything for upgrades, since you can download 
these new versions at your convenience.

Shortly after the 15 day evaluation period ends, VuePrint displays a reminder that the 
evaluation period has ended, and a request to register the program. This reminder was 
carefully designed to not interfere with further evaluation of the program past the 15 day 
period - all functionality is still enabled after the evaluation period.



Screen Saver
VuePrint can be installed as both a viewer and as a screen saver.    When installed as a 
screen saver, it displays graphics files on the screen when there is no activity for more than 
5 minutes.    The default setup causes it to search out all graphics files on the same drive as 
Windows, and to display these graphics files in random order every 15 seconds.    Any 
keypress, mouse click, or mouse movement will cause the program to exit.    Each time the 
screen saver exits, it remembers the last file that was displayed, and starts over again after 
5 minutes of inactivity displaying this same file.

The screen saver can by installed by choosing <Utilities|Install Screen Saver>.    The screen 
saver is just a copy of VUEPRINT.EXE that is copied into the Windows directory (normally c:\
windows) and named VUESAVER.SCR.    This help file is also copied into VUESAVER.HLP.    The 
Pro/32 Edition uses VUEPRO32.EXE, VUEPRO32.HLP, VUESAV32.SCR, and VUESAV32.HLP.

All the options for the screen saver are stored in the Windows directory in the file 
VUESAVER.INI for the 16-bit Edition and VUESAV32.INI for the Pro/32 Edition.    Any VuePrint 
option can be set up in this file.    For example, to disable the mouse during the screen saver,
set MouseButtonEvent=11 and MouseMovementEvent=11.

To configure the screen saver, you can either choose the <Utilities|Configure Screen Saver> 
menu item, or choose the <Setup> button from the <Desktop> Control Panel.

All the options that can be set on the screen saver setup screen are the same as the options 
in the VuePrint menus.    All these options do is set up the VUESAVER.INI or VUESAV32.INI 
configuration file.



File Formats
VuePrint reads six types of files:

Image files (.GIF, .BMP, .DIB, .RLE, .PCX, .TGA, .JPG, .TIF)

Sound files (.MID, .WAV, .MCI)

Movie files (.AVI, .MPG, .MMM, .MOV, .FLI, .FLC)

Slide Show files (.SLI)

Uuencoded files (.UUE, .UU1, .01, .MSG)

Zip files (.ZIP)

A file that doesn not have a sound or movie file extension is automatically recognized by the
first few bytes in the file. If the first few bytes of the file are not recognized, the software 
checks to see if the file is a Macintosh GIF or JPEG/PICT file.    If it is a Macintosh GIF or 
JPEG/PICT file, the header information is skipped and the file is read normally.    Note that any
image file may be optionally compressed with the zip format.    This means that you can 
compress files such as BMP or TGA, and they can be read directly by VuePrint without 
needing to decompress them first.    Note also that if the file is a UUENCODE or BASE64 
(MIME) file, it will also be automatically recognized and read.

GIF Files (.GIF)

VuePrint will read both GIF 87a files and GIF 89a files.    GIF files that have Macintosh headers
are also recognized.    The only GIF 89a attribute that is used is transparency, the other GIF 
89a extensions (such as text overlays) are ignored. Multiple Image GIF files are supported, 
and the image that is displayed is the composite of all the multiple image segments.    
Comments that are contained in the GIF file are stored in the Comments window, and are 
saved when a GIF, JPEG, or TIFF file is written.

Bitmap Files (.BMP, .DIB, .RLE)

All BMP, DIB, and RLE bitmap formats are supported, including compressed and OS/2 
bitmaps.

PC Paintbrush Files (.PCX)

PCX files that are version 3.0 or less are supported, including reading the 24-bit format.    The
CGA color palette information is ignored.    The <File|Save as...> option creates 8-bit PCX 
files.

Targa Files (.TGA)

All Targa file formats are supported.

JPEG Files (.JPG)

VuePrint reads JPEG files that use either the JFIF format (.JPG extension) or the Macintosh 
JPEG/PICT format.    Comments that are contained in the JPEG file are stored in the Comments
window, and are saved when a GIF, JPEG, or TIFF file is written.



TIFF Files (.TIF)

VuePrint reads and writes TIFF files that conform to the TIFF 6.0 specification, including files 
compressed with LZW, CCITT Group 3, and CCITT Group 4 methods.    Tiled TIFF files are not 
supported.    Comments that are contained in the TIFF file are stored in the Comments 
window, and are saved when a GIF, JPEG, or TIFF file is written.

Sound Files (.MID, .WAV, .MCI)

Standard MIDI and WAV files are supported.    If you only have the PC Speaker sound driver, 
you will need to select the <Sound|Synchronous> option.    MIDI files can not be played with 
the PC Speaker sound driver.

MCI files contain MCI commands. Refer to various Microsoft descriptions of MCI command 
strings for more details. In order for MCI files to interact properly with the slide show feature,
one MCI command should use the <notify> parameter. When the command completes, 
VuePrint will automatically issue the <close all> MCI command. For example, the following 
MCI file will play track two of an audio CD player, and will continue a slide show after the 
track completes:

# This script plays track two on an audio cd
open cdaudio alias cd
set cd time format tmsf
play cd from 2 to 3 notify

Movie Files (.AVI, .MPG, .MMM, .MOV, .FLI, .FLC)

If you have the MCI drivers for AVI,    MPG, MMM, MOV, FLI, or FLC files installed, VuePrint is 
able to play these movies.    You can also use the Media Player thats included in the 
Accessories folder to play these files.

Slide Show Files (.SLI)

Slide Show files (.SLI) are just text files containing a list of image, sound, and movie files, 
one file name per line. This list can contain other .SLI files, which can refer to other .SLI files,
and so on (up to eight times). A slide show list is also automatically created with you use the
<File|Open...> menu to select a single file.    A slide show list is also created when you 
choose the <Slideshow|File spec...> menu.

Slide show files can contain image, sound, and movie files, and the slide show can play back 
sound and movie files at the same time the images are changing.    The minimum delay 
between any two image, sound, and movie files can be set with menu options.

Uuencoded files (.UUE, .UU1, .01, .MSG)

Uuencoded files are commonly used on the Internet to convert image files into a text file 
that can be sent over the Internet as e-mail.    Please refer to the section on Internet 
Graphics for more details.

ZIP files (.ZIP)

ZIP files are compressed files that can contain multiple files within them.    VuePrint will 
directly read zip files produced by pkzip version 2.04g, which has been widely used since 
February 1, 1993.    You may need other ZIP utilities to read zip files produced by older 



versions of pkzip.



File Manager
VuePrint can be integrated with the Windows File Manager by choosing the <Utilities|Install 
VuePrint> to associate VuePrint with the Image, Sound, Movie, and Slide Show file types.    
You can use <Utilities|Remove VuePrint> to disassociate VuePrint and restore the previous 
associations. When VuePrint is installed, you can use the File Manager to double-click on any
Image, Sound, Movie, or Slide Show file, and VuePrint will be automatically started to display
(or play) the file. If you double-click on a uuencoded file (.uue, .uu1, .01, or .msg) VuePrint 
will attempt to automatically decode and display any image contained withing this file.    
VuePrint will also print images chosen in the File Manager.

You can also use the <Utilities|Install Extension...> and <Utilities|Remove Extension...> 
commands to install and remove File Manager associations for individual file extensions.



Program Manager
VuePrint provides a complete command line argument processing system that gives you the 
capability to install different VuePrint icons to do different things. Because the command line
processing is also performed when VuePrint is started from another program, you can use 
VuePrint as a viewing subsystem for other applications. The command line can contain two 
types of arguments - options and file names. File names have complete wildcard support, 
and the additional feature that filenames ending in <...> will recursively descend a directory
tree looking for additional files.

The command line is processed from left to right.    Valid command line options can have the 
following forms:

-name
/name
-name=value
/name=value

If there is no value specified, the value 1 is used.

The names of the options are the same as those in the VUEPRINT.INI option file, and override
the settings in that file. Command line options can be abbreviated, are not case sensitive, 
and the first one matching the command line option is used. There are four additional 
command line options that are not used by the .INI file:

/Directory=name
/Print
/ConvertToXXX (where XXX can be GIF, BMP, PCX, TGA, JPG, or TIF)
/Install

The /Directory=name option changes the current drive and directory to <name>. This is 
useful when VuePrint is used as a subsystem of another program.

The /Print option causes every file on the command line to be displayed and then printed.    
Only the first file sets up the printer options, the remainder use the same printer options.    
This lets you do unattended printing of large numbers of image files.

The /ConvertToXXX option causes every file on the command line to be displayed and then 
converted to another format.    This lets you do unattended conversion of large numbers of 
files.

The /install option invokes the <Utilities|Install VuePrint> menu item when VuePrint starts 
up.



Interrupting
VuePrint has been designed to let you interrupt loading files, since this operation can 
sometimes take some time.    Any menu choices that need to read or change the current 
image will interrupt the currently loading file.    Other options that interrupt loading the 
current image include those that save and restore option settings, change the number of 
thumbnails, install or remove VuePrint or the Screen Saver, invoke Help, or display any 
dialog box.

For example, pressing the <X> key while a file is being loaded will execute the <File|Exit> 
command, causing VuePrint to immediately exit.



Options
There are more than 100 different options that can be used for VuePrint.    These options are 
stored in a file in the same directory as the program.    The name of the .INI file matches the 
name of the program.    For instance, if you copy C:\WINDOWS\VUEPRINT.EXE to C:\TEST\
VUETEST.EXE and then run VUETEST.EXE, the file C:\TEST\VUETEST.INI is used to hold the 
options for this program.    This lets you install multiple copies of VuePrint, each with different
options.

Each option has a default value, a minimum value, and a maximum value.    In addition, 
there are different default values when the program is run as a viewer and as a screen saver.

The following options can be used in the .INI file and on the command line. Their names, 
default values, default screen saver values, minimum values, and maximum values are:

Options from File menu

Option Name Default Saver Min Max
OpenIndex 7 7 1 14
SaveAsIndex 1 1 1 6
DeleteIndex 7 7 1 14
DecodeIndex 11 11 1 14
EncodeIndex 7 7 1 14
UnzipIndex 12 12 1 14
ZipInfoIndex 12 12 1 14
TopMargin 0 0 0 none
LeftMargin 0 0 0 none
RightMargin 0 0 0 none
BottomMargin 0 0 0 none
ShowComments 0 0 0 1
ShowLog 0 0 0 1

Options from Image menu

Option Name Default Saver Min Max
Rotate 0 0 0 7
Brightness 5 5 1 9
Contrast 5 5 1 9
Invert 0 0 0 1

Options from Sound menu

Option Name Default Saver Min Max
SoundEnable 1 1 0 1
SoundSynchronous 0 0 0 1
SoundLoop 0 0 0 1

Options from Movie menu

Option Name Default Saver Min Max
MovieEnable 1 1 0 1
MovieSynchronous 0 0 0 1
MovieLoop 0 0 0 1



Options from Slideshow menu

Option Name Default Saver Min Max
RunSlideshow 0 1 0 1
DelayBetweenImages 5 15 0 none
DelayBetweenSounds 0 0 0 none
DelayBetweenMovies 0 0 0 none
RandomOrder 0 1 0 1
EraseNewPages 1 1 0 1
KeystrokeEvent 0 9 0 10
MouseButtonEvent 0 9 0 10
MouseMovementEvent 0 9 0 10
ImageDisplayEvent 0 0 0 10
ScreenDoneEvent 0 0 0 10
SlideshowDoneEvent 0 0 0 10



Options from Options menu

Option Name Default Saver Min Max
RememberOptions 0 0 0 1

ThumbnailsEnable 0 1 0 1
ThumbnailsRandom 0 0 0 1
ThumbnailsAnnotate 1 0 0 1
ThumbnailsOutline 0 0 0 1
ThumbnailsAcross 8 1 1 999
ThumbnailsDown 6 1 1 999

FillWindow 0 1 0 1
AlwaysOnTop 0 1 0 1
DisplayInColor 1 1 0 1
DisplayDithered 0 0 0 1
DisplayCaption 0 0 0 1
EnableTrueColor 1 1 0 1
Enable3dControls 1 1 0 1
EnableLargeDialogs 1 1 0 1
WarnLargeDialogs 1 0 0 1

PrintInColor 1 1 0 1
PrintDithered 0 0 0 1
PrintCaption 0 0 0 1

BackgroundRed 192 0 0 255
BackgroundGreen 192 0 0 255
BackgroundBlue 192 0 0 255
ForegroundRed 0 192 0 255
ForegroundGreen 0 192 0 255
ForegroundBlue 0 192 0 255

GIFInterlaced 0 0 0 1
GIFTransparent 0 0 0 1
GIFColors 256 256 2 256
GIFLZWEnable 1 1 0 1

JPEGTwoPass 0 0 0 1
JPEGUseDithering 1 1 0 1
JPEGUseMonochrome 0 0 0 1
JPEGOutputMonochrome 0 0 0 1
JPEGOutputOptimize 1 1 0 1
JPEGOutputQuality 75 75 0 100
JPEGOutputSmoothing 0 0 0 100
JPEGKBytesMemory 2048 1024 1 none

TIFFCompression 1 1 1 5

QuickLook 0 0 0 1
SortPalette 1 1 0 1

OutputWidth 0 0 0 none
OutputHeight 0 0 0 none
EncodeLines 400 400 1 none



DitherQuality 2 2 1 3

Effect 1 1 1 12

AutoScale 0 0 0 1
AutoFit 1 1 0 1
AutoCrop 0 0 0 1
AutoDither 0 0 0 1
AutoComments 0 0 0 1
AutoSearch 0 1 0 1
AutoResume 1 1 0 1

SlideshowPassword 0 0 0 1
StartupPassword 0 0 0 1

Window position settings

Option Name Default Saver Min Max
XImage 0 0 0 999
YImage 0 0 0 999
WImage 1000 1000 1 1000
HImage 1000 1000 1 1000
MImage 0 0 -1 1

XComments 0 0 0 999
YComments 667 667 0 999
WComments 1000 1000 1 1000
HComments 333 333 1 1000
MComments 0 0 -1 1

XLog 0 0 0 999
YLog 667 667 0 999
WLog 1000 1000 1 1000
HLog 333 333 1 1000
MLog 0 0 -1 1

The options for controlling window positions are designed to be independent of the display 
resolution.    These values range from 0 to 1000, where 1000 is the full width (or height) of 
the display.    The option beginning with M is -1 for a minimized window, 0 for a normal 
window, and 1 for a maximized window.

Note that all options are stored as a 16-bit signed number, so the maximum value for any 
option is 32767.



Mouse
The left mouse button can be used to select a rectangular subset of an image.    This subset 
of the image is used when displaying, printing, or saving an image.    The right mouse button
is used to move a zoomed-in image within the window (you will see a hand icon when 
moving).    A double-click of the right button will select the whole image.

When the left mouse button is clicked, and less than 16 pixels are selected, the image is 
zoomed by a factor of two, centered on the position of the mouse.    If the control key is 
pressed while the left mouse button is clicked, the image will be zoomed out by a factor of 
two.    If the shift key is pressed with the left mouse button, the image is cropped, and if the 
control and shift keys are both pressed, the image is rotated.

If the display has multiple thumbnails and the left mouse button is clicked on an image, then
thumbnails will be turned off and the image that you click will be displayed by itself in the 
window.

If both mouse buttons are pressed at once, the program will exit.



Keyboard
Most menu items have a keyboard equivalent.    The key that corresponds to the menu item 
is displayed along with the menu.

The arrow keys on the keyboard will move a zoomed image.    If the shift key is pressed along
with an arrow key, the zoomed image will move in window-sized jumps.    If the control key is 
pressed along with an arrow key, the zoomed image will move in single-pixel jumps.    If the 
Alt key is pressed with an arrow key, the size of the zoomed area will be adjusted in single-
pixel jumps.

You can press one of the numeral keys from 1 to 9 before you press the space bar, 
backspace key, or enter key.    This will set the number of times to repeat this sequence.    For
instance, to skip forward 8 files, press the 8 key followed by the space bar.

Long-running MCI commands can be aborted by pressing Control-Break.



Hints for Improving Display Quality
If you get a display that seems fuzzy or grainy, you probably have your Windows display 
adapter configured for 16 colors.

If youre running Windows 3.1,    you can configure your display adapter for 256 (or more) 
colors by going to the Program Manager and opening the <Main> window.    Then open the 
<Setup> window, and choose the <Options|Change System Settings> menu.    Choose a 
display mode that has 256 (or more) colors, and then press <OK>.    If you can not find a 
display mode for 256 (or more) colors for your display type, select the last item in the list 
<Other display (requires disk from OEM)...>.    You will have to insert the diskette containing 
the display driver for your computer.    This diskette probably came with your computer, or 
came with your display adapter if you bought it separately.

If youre running Windows 95, use the right mouse button to click on the desktop and choose 
<Properties>.    Then click <Settings> and set the number of colors in the <Color Palette> 
section.

If your display still seems fuzzy or grainy when you configure your system for 256 colors, 
you probably have the Effects option set to something other than Direct, or you have the 
number of thumbnails across or down set to a number larger than one.    The reason for this 
is VuePrint needs to use a fixed palette for the display under these conditions, because two 
or more images (with 256 colors each) may be displayed on the screen at a time.    VuePrint 
has to make a compromise palette in order to display several images at the same time, and 
the compromise (fixed) palette is not always optimal for either image.    The solution to this 
is to configure your display for more than 256 colors (if your hardware supports it), or to set 
the effect to Direct, and the number of thumbnails across and down to one.

If your display is configured for more than 256 colors, you can improve the display quality of 
JPEG files by making sure the <Options|JPEG|Two pass> option is turned off. When this 
option is turned off, the full 16 million colors in the JPEG files are displayed.    This will also let
you read JPEG files faster, particularly very large JPEG files.

If you have several hard drives, you can set up an environment variable TEMP to tell 
VuePrint where to write temporary files when processing very large JPEG files with the 
<Options|JPEG|Two pass> option.

If you have a JPEG file that you suspect is bad, you can still view whatever is present in the 
file by turning off the <Options|JPEG|Two pass> option.



Internet Graphics (Uuencode, Base64)
You can find many different kinds of graphics files in the Internet usenet news groups.    For 
instance, the alt.binaries.pictures... hierarchy contains the majority of the Internet traffic in 
graphics files.

The graphics files in the usenet news groups are usually in a <uuencoded> format (it stands
for Unix-to-Unix-Encoded).    These files are often broken up into several pieces, because 
there is a limit on the size of a file that can be sent by e-mail to some Internet systems.    A 
uuencoded file begins with a line that looks like <begin 660 file.gif>.    It is then followed by 
multiple lines that begin with <M> and are 61 characters long.    The last three lines are 
usually a line that is shorter than 61 characters long, a line with the single character <`>, 
and a line that contains <end> by itself.

There is another type of file that looks a lot like uuencoded files.    This has lines that do not 
all begin with <M>, but have only the characters A-Z, a-z, 0-9, +, /, and =.    These are called
base64 or MIME files, and they can be read directly by the <File|Open...> command as well 
as read with the Decode... command.

A uuencoded or base64 file can also contain a few dozen lines of extraneous information at 
the top and bottom of the file.    You do not have to edit these lines out by hand, since the 
VuePrint program automatically discards this information when processing these types of 
files.

The first step to decoding these images is to download the uuencoded files to your hard 
drive on your computer.    Once you have downloaded the uuencoded files to your hard drive,
use VuePrint to decode these files.    To decode these files, put the pieces of the file in order 
in files named something like <file1.uu1>, <file1.uu2>, ... Then choose <File|Decode...> 
and double-click on the first file in a multiple file group (i.e. file1.uu1).    When you press OK, 
the pieces will be put together, and the original image file will be put in the same directory 
as the uuencoded files.    You can also skip the <File|Decode...> step and just use <File|
Open...> to open file.uu1.

If you want to diagnose problems, use a text editor to look at the uuencoded files.    The first 
file should look something like:

(some header text which is ignored)
begin 644 FILE.GIF
M1TE&.A=A``19`O<``A@P+)R9<VQI0\'*P'.':JFTFFZBAIA8GDE22'EC0ZFO
MN(&3=JBCCE];1FY[8-G?YLW3VIVBKWJ/F[:_M9)Z6[6[QB5;8IZ)665ZA+A2
M9;^=;X1M7$1A/&BG<,''T$Q.5I:AQL*KB)ABDFQ51H1YAIBX;9R1GIR$>:&N
(lots of 61-character lines beginning with <M>)
(some trailer text which is ignored)

The last file should look something like:

(some header text which is ignored)
(lots of 61-character lines beginning with <M>)
MQ-$X3>3AR$<:UPT*,$)]L3AB?XBJA(9(Q`N8XY_W0B*2(?S!&`4HX!A&5P!C
MJ*$83Q`&(?0P!3WLH`MEH`8D]!$>0ACB+6A(PPA2D`8HW*(G/=D:(DP0`6BX
9P`,JWA,RGC`>JKV6/C?JAD/L,[]>!`0`.VA(
`
end
(some trailer text which is ignored)



Each file in-between should consist of 61-character lines beginning with <M>, with header 
and trailer text that is ignored. Note that the 61-character lines above are just    examples - 
your specific files will have different text.

If one of the files ends with a line that begins with <M> but is shorter than 61 characters, 
then it probably has been shortened, and the resulting file will be corrupt.    When VuePrint 
reads a file that is corrupt, it displays a small white box in the middle of the screen.



Limitations
VuePrint reads GIF, DIB, BMP, PCX, TGA and TIFF files that have a maximum width of 4096 
with the 16-bit Edition, and 8192 with the Pro/32 Edition.    JPEG files can have a maximum 
width of 2048 with the 16-bit Edition, and 8192 with the Pro/32 Edition.    All image files can 
have a maximum height of 6000 with the 16-bit Edition, and 8192 with the Pro/32 Edition.    
If an image can not fit into the available memory, every other pixel and line is dropped until 
it fits.

The maximum number of files that can be selected in the <File|Open...> is limited by a 2048
character buffer for holding the file names.

MCI commands can be a maximum of 249 characters long.    The MCI command result can 
also be a maximum of 249 characters long.



Upgrading
You can obtain the latest version of VuePrint from America Online, CompuServe, and the 
Internet.    It is also available from other on-line services and several CD-ROM distributors.

America Online: Choose the <Go To|Keyword...> option and enter <Graphics>.    
Then select <Recommended Utilities>.    You can also go to 
keyword FTP to access the ftp site below.

CompuServe: Go to the GRAPHSUPPORT Forum, Library 3 (GIF Viewers), and 
download VUEPRI.EXE.      You can also go to the FTP area to 
access the ftp site below.

FTP: host name: ftp.primenet.com
directory: /users/h/hamrick
account: anonymous
password: (your e-mail address)

WWW: http://www.primenet.com/~hamrick/

After you register VuePrint, you will receive instructions for downloading the Pro/32 Edition of
VuePrint.    This is a 32-bit program that is significantly faster at reading JPEG files than the 
standard 16-bit program.    If you are using Windows 3.1 or 3.11, you will also need to obtain 
the win32s software to run this.    The Pro/32 Edition works well on both Windows NT and 
Windows 95.
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File Menu
The File menu provides commands to open files, save files in six different formats, print 
images, advance the slide show list, copy and delete files, process uuencoded files, process 
zip archives, control the comments and informational windows, and exit the program.

Open... opens an image, or sound, or movie file. You can select multiple 
files by using control-click to add single files, or shift-click to 
select a range of files. If only a single file is opened, the other 
image, sound, and movie files in the same directory are added 
to the slide show list.    Only files of the type specified in the File 
Types control are added to the slide show list. 

Close closes the currently open files and clears the screen.    This can 
be used even while a file is being loaded.

Save as... saves the currently selected image in a file.    The file format is 
determined by the file extension.    If the file extension is not 
recognized, then the file format is determined by the File Type 
control in the dialog.    The image is saved in its rotated and 
cropped format, with the same palette as currently displayed.    
The width and height of the image saved can be changed by the
<Options|Output|Output width...> and <Options|Output|Output 
height...> menu items (if zero, the current image width or 
height is used).    The contents of the comments window will 
also be saved to GIF, JPEG, and TIFF files. 

Save wallpaper... saves the currently selected image (rotated, clipped, and 
dithered) to the Windows directory.    The image is scaled up to 
the size of the screen if the AutoScale option is enabled, and is 
always scaled down to the size of the screen if larger than the 
screen.    This command then sets this file as the desktop 
wallpaper. 

Print... prints the current image. 

Print setup... displays a printer setup dialog box. 

Print margins... lets you specify the size of the margins (in millimeters)    Note 
that these are not always margins to the edge of the paper, 
only margins relative to the print area.    If you want to be 
precise about the margins, your printer manual will probably 
give you information about the positioning of the print area on 
the paper.    There are 25.4 millimeters per inch, but an integral 
number of millimeters must be entered.    Note that often one 
dimension of the printed image will not extend all the way to 
the margin, since the aspect ratio of the image does not always 
match the aspect ratio of the print area. 

Decode... lets you decode files that have been encoded using uuencode 
or base64 (MIME).    These files are commonly used for 
transmitting Internet Graphics in Internet news groups.    The 
files may contain extra header and footer lines, and files may 
contain parts of a uuencoded files, entire uuencoded files, or 
multiple uuencoded files.    The only restriction is that the files 



will be processed in alphabetical order.    The most convenient 
naming scheme is file.uu1, file.uu2, ... file.uu9, file.u10, file.u11,
etc.    You can also use .01, .02, .etc.    Note that you only have 
to select the first file name in the series (.uu1 or .01) and the 
remainder will be read automatically.

Encode... lets you encode files in the uuencode format.    Files are written 
using the same file name as the input file, but with 
extensions .uu1, .uu2, ... .uu9, .u10, .u11, etc.    The maximum 
number of lines per file can be changed by changing the 
<Options|Output|Encode lines...> menu item.    This option is 
used to compute the number of files that must be written, and 
then the actual number of lines per file is computed to try to 
make each file roughly equal size.    Very large input files may 
have more lines than expected, since at most 99 output files are
created per input file. 

Display thumbnails lets you display the currently opened file list in thumbnails.    
Each time this command is run a new page of thumbnails is 
displayed.    After the last page is displayed, the thumbnails are 
turned off. 

Next loads the next file in the Slide Show list. 

Random loads a random file from the Slide Show list. 

Previous loads the previous file in the Slide Show list. 

Copy image to... lets you make a copy of the current image file. 

Copy sound to... lets you make a copy of the current sound file. 

Copy movie to... lets you make a copy of the current movie file. 

Delete image... lets you delete the current image file. 

Delete sound... lets you delete the current sound file. 

Delete movie... lets you delete the current movie file. 

Delete files... lets you delete a number of files at once. 

Convert to ??? lets you specify image files that will be converted to GIF, BMP, 
PCX, TGA, JPG, or TIF.    The new file will be written in the same 
directory with the new extension. 

Unzip... lets you extract files from a zip archive.    You will be asked to 
specify the directory that you want to extract the files into.    
VuePrint is able to read any zip file created by pkzip version 
2.04g, but older zip files can not be read.    Please refer to ZIP 
Utilities for information about utilities for reading older zip files 
or creating zip files.

Zip info... lets you display information about files in a zip archive.



Show comments displays a window containing comments contained within the 
currently displayed image (up to 100 lines). 

Show log displays a window containing a log of the last 100 VuePrint 
events since the program was started. 

Exit exits VuePrint. 



Edit Menu
The Edit menu provides commands to exchange data with the clipboard.    It lets you copy 
and paste the current image, copy and paste the comment text associated with an image, 
and copy the picture in the window to the clipboard.    Note that the clipboard can hold either
an image or comments, but not both at the same time.    When an image is pasted from the 
clipboard the comments window is cleared.

Copy image copies the current image to the clipboard.    If the image has 24 
bits per pixel, it is converted to 8 bits per pixel before copying 
to the clipboard.    The image is copied in its rotated and 
cropped format, but at the original resolution of the image and 
with the original palette.    If the image is dithered on the 
display, it will not be dithered after copying to the clipboard. 

Paste image copies an image from the clipboard to the current image.    The 
clipboard must contain a bitmap, a metafile, or a device-
independent bitmap. 

Copy comments copies the text in the comments window to the clipboard. 

Paste comments copies text from the clipboard to the comments window. 

Copy window copies the current window to the clipboard.    The window is 
copied at the resolution of the window and with the same 
palette as the window. 



Image Menu
The Image menu provides commands to manipulate the current image.    Note that images 
are saved with the zooming, cropping, rotating, mirroring, and flipping applied, with the 
same brightness, contrast, and invert settings as currently displayed.    The brightness, 
contrast, and invert settings for the image are also used for adjusting the brightness, 
contrast, and invert settings on the printouts.

Zoom in zooms the image by a factor of two.    If the <Options|Auto|
Scale> is selected, images smaller than the window will be 
scaled up to fill the window. 

Crop crops borders off the edges of the image.    A border is detected 
by searching for borders that contain significantly fewer colors 
than the image as a whole.

Zoom out zooms out by a factor of two. 

Rotate rotates the image 90 degrees clockwise. 

Mirror mirrors the image horizontally. 

Flip flips the image vertically. 

Brighter increases the overall brightness of the image (and printout). 

Dimmer decreases the overall brightness of the image (and printout). 

More contrast increases the contrast (gamma) of the image (and printout). 

Less contrast decreases the contrast (gamma) of the image (and printout). 

Invert inverts the image.      This is useful if you want to print an image,
such as a map, that consists of white graphics on a black 
background.

Reset resets the image to the default zoom factor, rotation, 
brightness, contrast, and invert settings. 

Reload reloads the currently displayed image.    This is useful if you 
have changed options that effect how an image is loaded, 
particularly JPEG options.



Sound Menu
The Sound menu provides commands to manipulate the currently loaded sound file.

Enable enables playing sounds.

Synchronous enables playing sounds synchronously.    This is useful if you 
have a sound driver for the PC speaker, which requires playing 
sounds synchronously.    MIDI files can not be played using the 
PC speaker sound driver.

Louder increases the volume for .WAV files.    Does not work with the PC
speaker driver.

Softer decreases the volume for .WAV files.    Does not work with the 
PC speaker driver.

Loop replays the current sound file when it reaches the end.

Replay replays the current sound file.



Movie Menu
The Movie menu provides commands to manipulate the currently loaded movie file.

Enable enables playing movies.

Synchronous enables playing movies synchronously.    This is not really useful,
but is provided in case you have an MCI driver that does not 
work without this option.

Loop replays the movie file when it reaches the end.    This only works
if you play movies asynchronously.

Replay replays the current movie file.



Slideshow Menu
The Slideshow menu provides commands to set up a slide show.    When the slide show is 
running, all other functions in VuePrint can be used.    The only thing that running a slide 
show does is advance to the next image, sound, or movie file after the delay between 
images, sounds, or movies completes.    This menu also provides options for controlling what 
happens when various events happen while the slide show is running.

Run slideshow controls the running of slide shows. The list of files for the slide 
show can come from two places - multiple files opened with 
<File|Open...> ,or <Slideshow|File spec...>.    The order of 
displaying files in a slide show is either the next, previous, or a 
random file in the list, depending on how the current file was 
selected. If the <Slideshow|Random order> option is selected, 
then a random file is always selected as the next image in a 
slide show sequence.

Go to slide... lets you enter the file name of a file that is already in the slide 
show list.    This file, if it is found in the list, will be loaded and 
displayed, otherwise the current file will be reloaded and 
displayed. 

File spec... lets you enter the file specification of files for the slide show list.
The first file found is loaded and displayed.    Note that this file 
spec can be a single file name of a .SLI file (e.g. c:\test\
slides.sli), a directory where images are located (e.g. c:\
images\), a wildcard specification (e.g. c:\images\*.gif), or a 
special name indicating that all subdirectories should be 
searched (e.g. c:\images...).    If a directory name is specified, 
and the Auto Search option is enabled, all subdirectories will 
also be searched.    The types of files that are selected are those
selected in the <File|Open...> dialog box.

Delay between images... lets you enter the minimum delay between successive image 
files in a slide show. 

Delay between sounds... lets you enter the minimum delay between successive sound 
files in a slide show. 

Delay between movies... lets you enter the minimum delay between successive movie 
files in a slide show. 

Random order displays images in the slide show list in random order while the 
slide show is running. 

Erase new pages erases the whole screen when the slideshow is running with 
thumbnails, and slideshow advances from the last thumbnail to 
the first thumbnail. 

Exit on key exits the program when any key is pressed while a slide show is 
running. 

Keystroke event controls what happens when a key is pressed during a slide 
show.    There are 11 possible actions.    The default is to do what
normally happens when a key is pressed (i.e. do a menu item).   



You can instead choose to have the print command or save 
command automatically executed when a key is pressed, stop 
the slideshow, exit the program, or do nothing. 

Mouse button event controls what happens when a mouse button is pressed during 
a slide show.    The different events are described above.

Mouse movement event controls what happens when the mouse is moved during a slide 
show.    The different events are described above.

Image display event controls what happens after an image is displayed in a slide 
show.    The different events are described above.

Screen done event controls what happens after the last thumbnail is displayed in a 
slide show.    The different events are described above.

Slideshow done event controls what happens after the last image in a side show is 
displayed.    The different events are described above.



Options Menu
The Options menu provides commands to manipulate various VuePrint options, and to save 
and restore all options (including window positions).

Save options saves the current setting of all options in VUEPRINT.INI.    This 
file is located in the same directory as VUEPRINT.EXE.    If youre 
running VuePrint with a different file name (i.e. VUEPRO32.EXE),
then the options will be stored with the same name (i.e. 
VUEPRO32.INI).

Restore options restores all options from the .INI file. 

Default options sets all options to their default values.    If you want to save 
these default settings in the .INI file, choose <Options|Save 
options> after this. 

Remember options saves the current setting of all options when the program exits.

Thumbnails enable... turns on thumbnail display mode.    This will divide the window 
into a rectangular grid for displaying multiple images in the 
window at the same time.

Thumbnails random displays images in thumbnails in random positions on the 
screen.    The size of these thumbnails is determined by the 
number of thumbnails across and down.    This option has no 
effect if both the number of thumbnails across and down are set
to 1. 

Thumbnails annotate displays the file name of the image at the bottom of the 
thumbnail.    This option has no effect if both the number of 
thumbnails across and down are set to 1, or if the <Options|
Thumbnails|Random> option is selected. 

Thumbnails outline displays an outline around each thumbnail. 

Thumbnails across... lets you enter the number of images to display in thumbnails in 
a window in the horizontal direction.    Note that if you are using 
a 256-color display and multiple thumbnails across, the image 
will appear grainy due to VuePrint using a fixed palette for 
dithering.

Thumbnails down... lets you enter the number of images to display in thumbnails in 
a window in the vertical direction.    Note that if you are using a 
256-color display and multiple thumbnails down, the image will 
appear grainy due to VuePrint using a fixed palette for dithering.

Fill window removes the border and menu bar from the window.    You can 
toggle this on and off by pressing the Escape key. 

Always on top displays the VuePrint window in front of all other windows.    For 
instance, if you have a clock displayed on top of all your 
windows and you run VuePrint, this option will make the 
VuePrint window cover the clock window.



Display in color enables displaying images in color. 

Display dithered on a 256-color display, uses a fixed color palette that is 
optimized to look good for a wide range of images.    Use this 
option if you want to run multiple copies of VuePrint at the same
time on a 256-color display.

Display caption displays a caption at the bottom of the picture containing the 
file name.

Enable true color lets VuePrint use the full capabilities of a display with more than
256 colors.    If this option is not enabled, then VuePrint will 
display at most 256 colors on the display.    This option is useful 
to compensate for bugs in display drivers, particularly some 
older Cirrus Logic display drivers.

Enable 3d controls lets VuePrint use the 3-D controls library to give 3-D effects to 
dialog boxes.    It searches for the 3-D controls DLL in the 
Windows system directory to determine whether to use 3-D 
controls.    The 3D controls library is not used with Windows 95.

Enable large dialogs causes VuePrint to use larger Open/Save dialogs instead of the 
standard Windows File Open/Save dialogs.

Print in color enables printing images in color. 

Print dithered lets you print images using VuePrint dithering.    You may want 
to enable this option when working with some types of dot-
matrix printers that normally use a coarse pattern to 
approximate continuous tone images.    If you use this option, 
set up the printer dialog to use no dithering since it is 
redundant and will just make the printout take longer.

Print caption displays a caption at the bottom of the printout containing the 
file name.

Background color... lets you choose the background color for images, which is used 
for the border around images. 

Foreground color... lets you choose the foreground color, which is used to display 
text and borders for thumbnails. 

GIF Interlaced causes GIF files to be written with interlacing.    This makes the 
files appear progressively when viewed by some types of 
interactive viewers.

GIF Transparent causes GIF files to be written with transparency.    VuePrint finds 
the most commonly used color on the border of the image, and 
uses this for the transparent color.    This is useful when creating
GIF files for use on Web pages.

GIF Colors... sets the maximum number of colors to be written to a GIF 
image.    If this is less than the number of colors in the image, a 
new color palette will be computed and the image reduced to 
this new color palette.



GIF LZW enable causes GIF files to be written with LZW compression.    You may 
want to write the GIF files without any LZW compression for 
specialized applications.

JPEG Two pass causes JPEG files to be read in two passes. The first pass 
analyzes the colors, and the second pass reduces the data from 
24-bits to 8-bits per pixel.    If this option is turned off, the full 
24-bits per pixel will be stored in memory. Note that only 8-bits 
per pixel will be kept in memory if the <Options|JPEG|Use 
Monochrome> option is selected, or if the JPEG file only has one
color component.    Note also that the image will still look quite 
good on an 8-bit display if this option is not chosen.    If the 
<Options|JPEG|Two pass> option is not selected, images will 
load a bit faster, but will take a bit longer to be painted on the 
screen on 8-bit displays.    However, very large JPEG files will 
load much faster with this option turned off because the JPEG 
code will not need to write a temporary file between passes. 

JPEG Use dithering enables using Floyd-Steinberg dithering with the two-pass 
algorithm. 

JPEG Use monochrome enables converting the JPEG file to 8-bits per pixel of 
monochrome data when loading.    This also significantly speeds 
up loading JPEG files.

JPEG Output monochrome causes JPEG files to be written in monochrome 
(black/white). 

JPEG Output optimize performs entropy optimization when writing JPEG files, which 
should improve the quality of the image. 

JPEG Output quality... lets you set the quality of the image when writing a JPEG file.    
The quality ranges from 0 to 100, with 75 being the normal 
setting.    The lower the quality, the smaller the size of the JPEG 
file. 

JPEG Output smoothing...lets you set the amount of smoothing done on the image before
writing a JPEG file.    The smoothing ranges from 0 to 100, with 0
being the normal setting.    Smoothing is sometimes useful when
the image is dithered, or has a lot of noise in it.

JPEG Kbytes memory... lets you set the maximum amount of memory used for buffering
data when you are using the <Options|JPEG|Two pass> option.    
This should normally be about half the amount of physical 
memory on your system.

TIFF No compression writes TIFF files with no compression.

TIFF CCITT RLE writes black/white TIFF files with CCITT RLE compression.

TIFF CCITT Group 3 writes black/white TIFF files with CCITT Group 3 compression.

TIFF CCITT Group 4 writes black/white TIFF files with CCITT Group 4 compression.

TIFF LZW writes grey-scale and color TIFF files with LZW compression.



Quick look causes images to be read quickly, and every 8th pixel and line 
to be discarded.    This is particularly useful for getting a quick 
look at JPEG files, since it is approximately seven times faster 
than normal JPEG file loading.    Choosing this option causes the 
currently displayed image to be reloaded.

Sort palette causes images that have palettes to sort the palette according 
to how often the colors are used.    This is useful because 
Windows can only display 236 different colors, but many images
have 256 colors.    If the palette is sorted to favor the more 
commonly used colors, the appearance of images is often 
improved.

Output width... sets the width of the file written with <File|Save as...> (if non-
zero).

Output height... sets the height of the file written with <File|Save as...> (if non-
zero).

Encode lines... sets the maximum number of lines to write to a single file while 
encoding files.    Note that the number of lines in a file may be 
larger than this if the total number of files would otherwise be 
larger than 99.    The default value of 400 is set so these files 
can be sent in pieces on America Online. 

Dither quality lets you trade off between dither quality and speed.    The low 
quality setting paints the screen the fastest, and the high 
quality setting looks the best.    The default is the medium 
quality setting. 

Effects lets you choose how the screen is repainted.    There are 12 
different effects you can choose for repainting.    Note that if you
are using a 256-color display and an effect other than <Direct>,
the image will appear grainy due to VuePrint using a fixed 
palette for dithering.

Auto Scale automatically scales images to fill the window.    It maintains the
width/height ratio of the image, so one dimension of the image 
may not extend to the edge of the window.

Auto Fit when the <Options|Auto|Scale> option is off, automatically 
reduces large images to fit inside the window.    Also causes the 
areas of an image selected by the mouse to be fit within the 
window borders.

Auto Crop automatically crops images after loading.    The borders around 
an image are cropped if they contain substantially fewer colors 
than the image as a whole.

Auto Dither automatically dithers images if there is a substantial percentage
of the picture that can not be represented accurately with the 
colors that are available on the display. 

Auto Comments automatically displays the comments window after loading an 
image that contains comments, and removes the comments 



window if the image contains no comments.    Only GIF, JPEG, 
and TIFF files can contain comments. 

Auto Search automatically searches all subdirectories (up to 8 levels deep) 
for image files when a directory is specified in the File spec... 
option. 

Auto Resume automatically saves the current directory and current image on 
exit. If the slide show is running when the program starts, the 
slide show starts up where it left off. The current directory is 
also restored when the program is restarted, unless VuePrint is 
started from the File Manager (i.e. has file names on the 
command line).    The current directory can be overridden by the
/Directory=xxx command line option.

Startup password causes VuePrint to prompt you for the screen saver password (if
it has been set up) before starting VuePrint.

Slideshow password causes VuePrint to prompt you for the screen saver password (if
it has been set up) before stopping a running slide show. 

Set password... lets you set up or change the screen saver password.    If it has 
previously been set up, you need to enter the old password 
before being able to set up a new password.    You can delete 
the old screen saver password by editing CONTROL.INI in the 
Windows directory and deleting the line that begins with 
<Password=>.



Utilities Menu
The Utilities menu provides commands to install and remove VuePrint, and to install, 
remove, and configure the VuePrint Screen Saver.

Install VuePrint saves current File Manager associations, sets up associations for
VuePrint, copies VUEPRINT.EXE and VUEPRINT.HLP to the 
Windows directory, deletes VUEPRINT.INI from the Windows 
directory, and installs the VuePrint icon in the Accessories 
window.

Remove VuePrint reverses the above, restoring the system to the original state.    
The files VUEPRINT.INI, VUEPRINT.EXE, and VUEPRINT.HLP are 
not deleted and the icon is not removed if the running program 
is running from the Windows directory.

Backup VuePrint makes a backup copy of VuePrint to a floppy disk.    The files 
VUEPRINT.EXE and VUEPRINT.HLP are copied to the floppy disk.   
To re-install VuePrint from floppy disk, run VUEPRINT.EXE and 
choose the Install VuePrint command.

Install screen saver installs VuePrint as a screen saver for Windows.    VUEPRINT.EXE 
is copied to VUESAVER.SCR in the Windows directory, and 
VUEPRINT.HLP is copied to VUESAVER.HLP.    VUESAVER.INI is 
deleted.

Remove screen saver reverses the above, disabling the Windows screen saver.    The 
files VUESAVER.INI, VUESAVER.EXE, and VUESAVER.HLP are 
deleted from the Windows directory.

Configure screen saver lets you specify the options for the VuePrint screen saver.    
These options are stored in VUESAVER.INI in the Windows 
directory.    Note that any option that can be set up in 
VUEPRINT.INI can also be put into VUESAVER.INI.    The only 
difference between the two option files is that the default 
options for the screen saver are different from the default 
options for VuePrint.

Test screen saver starts the currently installed screen saver.    If you have installed
the VuePrint screen saver, it will be started.    Otherwise, 
whatever screen saver that is installed will be started.

Install extension lets you tell the File Manager that a given three-letter file 
extension is associated with VuePrint.    Whenever a file with this
extension is double-clicked in the File Manager, VuePrint will be 
started to display this file.

Remove extension removes an extension that was previously configured, and 
restores the previous association for that extension.    Note that 
all VuePrint file associations can be removed with the <Utilities|
Remove VuePrint> menu item.



Help Menu
The Help menu provides commands for getting help and registering VuePrint.

Contents... displays the table of contents of this Help file. 

Using help... displays help about the Help program. 

About... displays information about registering VuePrint, and lets you 
enter a VuePrint serial number. 



ZIP Utilities
VuePrint is able to read zip files created by pkzip version 2.04g and later.    If you have a zip 
file created by an older version of pkzip, or if you want to create zip files, you will need to 
get a zip utility.

The most commonly used MS-DOS utilility for reading and writing zip files is pkzip version 
2.04g.    It can be found on-line on America Online, CompuServe, and most other on-line 
services.    There are several excellent Windows programs for working with zip files, most 
notably WinZIP.    To find WinZIP on America Online, go to keyword <Software> and search 
using <WinZIP> as the keyword.    On CompuServe, GO IBMFF and search using <WinZIP> 
as the keyword.



MCI Drivers
To play sound files and movie files, you need to install MCI (Multimedia Command Interface) 
drivers.    You can tell what MCI drivers are already installed on your system by looking in 
WIN.INI in the section labeled [mci extensions].    .WAV files should be <waveaudio>, .MID 
files should be <sequencer>, .AVI files should be <AVIVideo>, .MMM files should be 
<MMMovie>, .MPG files should be <mpegvideo>, .FLC and .FLI files should be 
<Animation1>, and .MOV files should be <QTWVideo>.

The waveaudio and sequencer drivers usually come with sound cards.

To install AVIVideo, you need to get the Microsoft <Video for Windows> add-on.    The 
Animation1 driver is part of the Autodesk Animator add-on.    QTWVideo is part of 
<Quicktime for Windows> from Apple (an older version is free, the latest version needs to 
be purchased).

All of these video MCI drivers can be found by going to keyword <Software> on America 
Online and the IBMFF (IBM File Finder) area on CompuServe.

Microsoft has announced that they will be producing a software-only mpegvideo MCI driver 
some time in late 1995, and several vendors sell hardware-assisted MPEG playback cards 
with mpegvideo drivers.




